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Agenda:

1. Data entry and organization

2. Conducting t-test analyses

3. Multiple linear regression




Importing files into SPSS

Can upload .csv or .xlsx

rer) . Read CSV File

@ [ ] Welcome to IBM SPSS
File: Span Data.csv

N 1eti CogLab ID,Numbers,ltsd,Itss,Shortwords,Longwords,MathAcc,0Ospan
TBM SPSS StahStI'CS CSUF305L80S12-7,7,5,5,6,5,98,50
= CSUF305L80S12-14,9,9,7,7,7,95,54
New Files: Y CSUF305L80512-18,7,4,6,6,6,98,54
New Dataset CSUF305L80S12-2,7,7,5,6,7,98,54
-, CSUF305L80S12-12,5,5,5,5,5,98,50
) New Database Query... CSUF305L80512-15,7,7,7.7,6,96,54
CSUF305L80S12-13,7,5,5,6,4,100,55
Recent Files: CSUF305L80S12-11,7,5,6,4,3,98,48
. CSUF305L80S12-10,7,7,5,3,5,95,49
@ .../OneDrive - Cal State Fullerton/stepwiseregexample.spv CSUF305L80S12-6,7,8,6,7,5,98,48
CSUF3OSLS0512-1,54,4:4.4.8828
CSUF305L80S12-16,7,5,5,6,4,86,48
| CSUF305L80S12-8,9,7,7,6,5,96,54

First line contains variable names
~ Remove leading spaces from string values

~ Remove trailing spaces from string values De I i m ite r: CO m m a

Delimiter between values: Comma /
N

Decimal symbol: period |
r Text Qualifier: Double quote

Percentage of values that determine data type: g5

Cache data locally

Advanced Options(Text Wizard)
sGdiadiisay Sample Files ]
o | ? Cancel Paste Reset -
pen

i




Importing data from Qualtrics into SPSS

Survey Actions Distributions Data & Analysis Reports

jata Text Crosstabs Weighting

Recorded Responses 199

Go to your project on Qualtrics © e g 0
i Data & AnalySiS Page10f10 - > [ 4 Expon&lmpoanIEdit H-\mmvl

4 Export Dat

Since
[ ) E p t D t Q56 - What type of
S " 33 - Who can | Import Data... ight/s of
X O r a a organization is Q160 - What did you ‘:alk ot :)lf:\:.- Q152-What .o £l ‘ug';g y :
Recorded this? (e.g. find most ) class of Dr. @ Response Export Automation... N .
O Date @ - N I N questions? If you EBEE des iter did Actions
N s . have questions 2 ch¢ @ Response Import Automation... oin 3
service, special at Discoverfest 2019? N in?
R about this stu... Jent
interes... Manage Previous Downloads... iy
| o !

D own I 0a d | n g t h e d at a Download a data table Use the legacy exporter

i Common to use CSV’ but We [ csv | TSV I Excel | XML Google Drive | User-submitted files
Wi” Opt for SPSS Since that’s @ Statistical Analysis Package
V.

Statistical Package for the Social Sciences (SPSS) is one of the most
widely used software packages for survey analysis. This is an SPSS sav
data file with raw data, variable and value labels.

the software we’ll be using
e SPSS > Download

Learn more

Download all fields

More options Close ' Download




Imported Data into SPSS

Data View Variable View

[ NOX J prepsurvey2.sav [DataSet3] - IBM SPSS Statistics Data Editor
EIE Qe
FeTille 250 off 250 Vel Name Type Width Decimals Label Values Missing Columns Align Measure

1 ‘Q33 Numeric 40 0 Who can I talk t... |{4, agree}... |None 6 = Right f Scale

F@3| Faisz | L3511 F352 Q353 P 0354 P Q355 P 0356 ¢ Q357 & Q358 ¢ Q359 2 |ais2 Numeric 40 0 What class of D... {1, T/TH me... None 8 Right & scale

1 4 1 3 ‘035_1 Numeric 40 0 Which of the fol...|{1, First gen... /None 8 Right f Scale

2 4 2 1 1 4 Q35_2 Numeric 40 0 Which of the fol...|{1, Second g...None 7 Right & scale

3 ‘ 4 1 1 . 1 . . . . . . 5 Q35_3 Numeric 40 0 Which of the fol...| {1, Commuti... None 7 Right & scale

4 5 1 1 6 Q35_4 Numeric 40 0 Which of the fol...| {1, Commuti...| None 7 Right f Scale

5 4 1 1 1 7 ‘QSS_S Numeric 40 0 Which of the fol...|{1, Commuti... None 7 Right & Scale

6 ‘ 4 1 1 1 1 8 ‘Q35_6 Numeric 40 0 Which of the fol...|{1, Commuti... None 7 Right & scale

7 4 1 1 9 Q35_7 Numeric 40 0 Which of the fol... {1, Recruite... |None 7 Right f Scale

8 4 1 1 1 10 Q35_8 Numeric 40 (] Which of the fol...|{1, Internati... [None 7 Right & scale

9 4 2 11 Q35_9 Numeric 40 0 Which of the fol...|{1, Receivin... |None 9 Right f Scale

10 4 2 1 12 |a3s_10 Numeric 40 0 Which of the fol... {1, Coming ... |None 8 Right & scale

1 4 1 ! 13 ‘Q3S_11 Numeric 40 0 Which of the fol...|{1, Transfer ... None 8 Right f Scale

2 4 ! ! ! ! 14 ‘035_12 Numeric 40 0 Which of the fol...|{1, Transfer ... None 5 = Right f Scale

i -
_ Variable View M—
'IBM SPSS Statistics Processor is ready # Unicode:ON| | IBM SPSS Statistics Processor is ready|P | | |Unicode:ON| | ﬂ

Wow so easy....




Prepping data in SPSS

*Recode missing values

*Specifying “Measure”

*Merging data




Prepping data in SPSS: Missing Values for Multiple Choice Questions

Need to account for missing values so our analysis is accurate

3. If you checked “yes”, please state what

other language(s) you can speak: (Mark all that

applies.) .« . .
1D S ¢ SPSS assumes that the participant did
= panis .
Q3.2 O Vietnamese 1 = marked not answer the question (hence,
Q3 3 O Chinese ..
Q34 O Korean missing): Statistics
3.5 0 Ol.her:. If you If you If you If you If you
Q3_5_TEXT string checked checked checked checked checked
"yes", please "yes", please "yes", please "yes", please "yes", please
stat what stat what stat what stat what stat what
other other other other other
language(s) language(s) language(s) language(s) language(s)
Example dataset - you can you can you can you can you can
speak:(Mark speak:(Mark speak:(Mark speak:(Mark speak:(Mark
‘@0 @ (24 exampledata.sav [DataSet1] - IBM SPSS Statistics Data Editor a;lr!lltlzgt) a;gﬁzgt) aglllbﬁzgt) a;gﬁ::;t) a;lgl)rlzgt)
H % H E_%ﬂ - Falke | @ & %. ﬂ = III%] @ o\ Spanis'h. Vietnaméée Chines.e' Korea'n. Other - 'i'éxt
13: Visible: 11 of 11 Variables N Valid 3 1 0 0
$aQl & Q2 ‘ Q31 | 32 | 33 ‘ & Q34 ‘ &4 Q3_5_TEXT & Q4 a Q5_1_TEXT & Q5.1 & Q6 Missing 2 4 5 5
1 007 1.00| 1.00 . : : 4.00/3.61 . 1.00 Veam 1.0000 1.0000
2 008 1.00 . 100, . . 5.003.21 1.00 il s
3 009 00 ] . [ 4.002.78 1.00 - -
4 010 1.00 1.00 M ISS.I ng ] 5.00/3.40 1.00
5 011 1.00 1.00 data for Q3 1 4.003.10 1.00
_ Variable View
/IBM SPSS Statistics Processor is ready &4 Unicode:ON| |




Prepping data in SPSS: Missing Values Multiple Choice Questions

Transform > Recode into Same Variables { The New Value will be 0

| | | | 4 0nl 4 N JON ) Recode into Same Variables: Old and flew Values
- 00 @ Recode into Same Variables E— I e
Numeric Variables: Bl Vel { O value:
| &4 Please provide you... &5 If you checked "yes", please stat ... | . d - System-missing
| | &5 Do you speak a la... &5 If you checked "yes", please stat ... L ?o System-missing
" " " 3 - - _ VI Old --> New:
| | & If you checked "yes... &5 If you checked "yes", please stat ... - . System- or user-missing
&5 How likely are you ... + &5 If you checked "yes", please stat ... ) Range:
1 | g5 What is your curre... T Add
1 % What is your curre... —_ through Change
| | . ) Range, LOWEST through value:
If... (optional case selection condition) | ——— .
— Range, value through HIGHEST:
? Reset Paste Cancel OK )
| | All other values
g Concel |
PO @ (4 exampledata.sav [DataS
D e B
% H (= Uy . M ﬂﬁ S
Data set with recoded missing 7:Q3.4
variables: dal | $@ | $B1 | H®B2 | $WB3 | gaza |
. . 1 007 1.00 1.00 .00 .00 .00
Either O or 1, they either speak Qz — — o — —
’
the language (1) or they don’t 3 009 00 00 00 00 00
(O) 4 010 1.00 1.00 .00 .00 .00
5 011 1.00 1.00 .00 .00 .00

t




Prepping data in SPSS: Missing Values for Text Responses
Example: Q3 5 TEXT

Name Type Width Decimals Label Values Missing
7 Q3_5_TEXT ‘String ‘ 8 ‘0 ‘ If you checked "yes", please stat what other language(s) you can speak:(Mark all that applies.): Other - Text None ‘ None o || 1
| NON ) Missing Values

' No missing values

© Discrete missing values Click the “...” in under the Missing column
Range plus one optional discrete missing value FOF missing text responses, we traditionally
Low: High:

use -9 at C-REAL

Discrete value:

? Cancel (ORI




Prepping data: Adjusting our “Measure” column

1. Please provide your student 4. How likely are you to go to college? (Mark
. Ql 1D.:_string one.)
Nominal ﬁ Q4
O Extremely unlikely 1
The 3 options are Scale, Ordinal, and Nominal: 7. DGgs spealce lunguags other D O Unlikely 2 Ordinal
. 2
Scale: values represent ordered categories Nominal St 0 Yes 1 O Neutral 3
. . . . 0 1
with a meaningful metric, so that distance o Likely 4
. . D p— . O Extremely likely 5
comparisons between values are aiher anguage(s) you oo spesc: (ark all that | -
. applies.) 5. What is your current GPA tf)r this semester?
appropriate 10 Soanich Q5_1_TEXT, numeric @ Scale
. _ panis 0
Example: score of a student in SAT Q3.2 O Vietnamese 1= marked Q51 O Tdomotknow
Q3_3 O Chinese
exam Q3_4 O Korean 6. Do you intend to apply to college? Nominal
. R . Q3_5 O Other: 6 1
Ordinal: values represent categories with Q3_5_TEXT ___string © DY
o
ranking VV-_J
Example: 1=Highly satisfied, Nominal ns  Align | Measue |  Role
. e . . e = Left Nominal “ Input
2=satisfied, 3= neutral, 4= dissatisfied, — v \2 comr TN ot
5= hlghly d|Ssat|Sf|ed :_:E Right ‘&) Nominal ~ Input
Nominal: values represent categories with _[Erone [ ovomnal [N g
. = Right L&) Nominal “w Input
no ranking Cmme S [N e
Example: zip code or gender B N Input
77% Right 7&) Nominal l " Input
= Right ‘& Nominal “w Input
= Right [&) Nominal ™ Input
= Right ‘% Nominal “ Input




Prepping data: Merging

o . . .
Combining pre/post test data e Want to combine datasets
.. [ JOX ) (=2 lang2ex.sav [DataSet2] - IBM SPSS Statistics Data Editor
Oy | e ==
| & D & Attendance | & Score_posttest & Score_pretest % H =5 e & % . ﬂ =
1 9975309 0 53 48 Q
2 ‘ 9948278 1 80 75 |
Visible: 4 of 4 Variables
169427 4
# 9169 95 90 f D & Language & Exam1 &Yrs_in_progr -~
4 ‘ 8643086 3 95 90 am
1 710080 2 90 2
5 7988957 1 79 72 2 991442 2 78 2
6 7509550 1 67 GI’i 3 717816 2 s !
4 69519 2 56 1
7 6133087 2 91 86 . 06943 8 28 8
8 6115282 2 89 84 6 15953 2 89 1
9 ‘ 5396215 2 86 81 Z Ba181> 2 % 3
8 4510 2 72 2
10 4365151 3 88 83 9 543971 2 84 2
11 ‘ 4303020 1 83 78 10 22883 2 87 3
20712 90 3
2 : . s e O . R
13 ‘ 3316521 0 57 54 13 436183 1 78 1
14 3168177 0 67 66 14 464671 ! 45 1
15 500578 1 65 1
15| 2331702 1 61 56 i ss8588 8 28 L
16 1767276 0 51 46 17 846822 1 91 3
17 1328727 1 71 65 I 152498 ! 7 2
19 429405 1 63 1
18 ‘ 1323956 3 93 88 20 419648 1 81 3
19 926172 0 50 48 21
20 ‘ 661007 2 85 79
o |

_ Variable View

=T - T T




Prepping data: Merging different datasets

1. Have both datasets Open & \ang‘\ex..sav [DataSeﬂJ. - IBM SPSS Statistics Data Editor

lang2ex.sav [DataSet2] - IBM SPSS Statistics Data Editor

F g = i
ing vari - SHEe m B 13
2. Make sure matching variables have the same settings = L LE =
«“ . . ”
under “Variable View Q |
Visible: 4 of 4 Variables ‘ ‘Visible: 4 of 4 Variables
-~ & D & Language & Exam1 & Yrs_i:;progr - & D & Language & Examl & Yrs_i:r_nprogr o
Name Typ Width Decimal: Label
Name Type Width  Decimals n D Numeri: 18 ! o ecimas ¢ . L 720712 1 90 3 D 710080 2 i 2
1 D Numeric 18 0 2 112443 1 88 2 2 991442 2 78 2
2 Language Numeric 1 0 ]
2 Language Numeric 1 0 3 436183 1 78 1 3 717816 2 45 1
3 Examl Numeric 2 0 !
3 Examl Numeric 2 0 4 464671 1 45 1 4 69519, 2 56 1
4 Yrs_in_prog... Numeric 1 0 i
4 Yrs_in_prog... Numeric 1 0 N 5 500578 1 65 1 5 606943 2 78 2
: 6 588588 1 78 1 6 15953 2 89 1
7 846822 1 91 3 7 841815 2 98! 3
8 152498 1 79 2 8 4510 2 72 2
9 429405 1 63 1 9 543971 2 84 2
10 419648 1 81 3 10 22883 2 87 3
11 ° 11
12 12
13 13
14 14
15 -~
16 16
17 17




Prepping data: Merging different datasets

Data > Merge > Add Cases

Add Cases to lang2ex.sav[DataSet2]

Select a dataset from the list of open datasets or from a file to merge with the active dataset
© An open dataset

langlex.sav[DataSet1]

) An external SPSS Statistics data file

Browse...
Non-SPSS Statistics data files must be opened in SPSS Statistics before they can be used as part of a merge
?

Cancel

90 @ Add Cases From DataSet1
Unpaired Variables: Variables in New Active Dataset:
ID
Language
Examl
+
Pair
| Indicate case source as variable:
Rename... source01
(*)=Active dataset
(+)=DataSet1
? Reset Paste Cancel




Prepping data: Merging different datasets

After:

[ JON ) (4 lang2ex.sav [DataSet2] - IBM SPSS Statistics Data Editor

Before: SHEM «~ BLFl 1 B

@A langlex.sav [DataSet1] - IBM SPSS Statistics Data Editor [ BON ) (&8 lang2ex.sav [DataSet2] - IBM SPSS Statistics Data Editor
: 5 : ; : = : : . . . Q
\ Visible: 4 of 4 Variables
H N &£ &5 Language & Examl & Yrs_in_progr .
am
= aicl] | T ! : 9° i
Visible: 4 of 4 Variables isible: 4 of ariables > 991442 5 78 2
&b & Language & Examl & Yrs_in_progr — & D &> Language & Examl & Yrs_in_progr . 5 717816 3 4 1
am am
1 720712 1 90 3 1 710080 2 90 2 4 69519 2 56 !
5 606943 2 78 2
2 112443 1 88 2 2 991442 2 78 2
6 15953 2 89 1
3 436183 1 78 1 3 717816 2 45 1
7 841815 2 98 3
4 464671 1 45 1 4 69519 2 56 1 3 4510 2 72 2
5 500578 1 65 1 5 606943 2 78 2 . s43071 ) 4 3
6 588588 1 78 1 6 15953 2 89 1 10 22883 2 87 3
7 846822 1 91 3 7 841815 2 98 3 11 720712 1 90! 3 °
8 152498 1 79 2 8 4510 2 72 2 12 112443 1 88 2
9 429405 1 63 1 9 543971 2 84 2 13 436183 1 78 L
10 419648 1 81 3 10 22883 2 87 3 % 464671 ! + !
15 500578 1 65 1
11 ‘ o 11 °
16 588588 1 78 1
Lo ‘ Q 17 846822 1 91 3
13 ‘ 13 18 152498 1 79 2
14 14 19 429405 1 63 1
15 15 20 419648 1 81 3
16 16 21
17 17
s 10 I -

_ Variable View

oo = - = B




Prepping data: Merging pre/post test data

1. Have both datasets open A —
2. Make sure there’s an identification variable; variable we i o i i, R
1 9975309 0 48 | & & Score_posttest var
will use to match the two datasets together 2 9948278 1 75 | ; 9975309 53
- In this example, we have ID as the matching variable 3 9169427 4 % 2 9948278 80
4 8643086 3 90 3 9169427 95
5 7988957 1 72 4 8643086 95
6 7509550 1 61 5 7988957 79
7 6133087 2 86 6 7509550 67
8 6115282 2 84 7 6133087 91
9 5396215 2 81 8 6115282 89
10 4365151 3 83 9 5396215 86
11 4303020 1 78 10 4365151 88
12 3670778 1 56 11 4303020 83
13 3316521 0 54 12 3670778 63
14 3168177 0 66 13 3316521 57
15 2331702 1 56 14 3168177 67
16 1767276 0 46 15 2331702 61
17 1328727 1 65 16 1767276 51
18 1323956 3 88 17 1328727 71
19 926172 0 48 18 1323956 93
20 661007 2 79 19 926172 50
2 20 661007 85
22 4
Data View  Variable View
IBM SPSS Statistics Processor is ready 4 | | Unic (Dataviewy variable View

' |IBM SPSS Statistics Processor is ready & 'Unicode:ON




Prepping data: Merging pre/post test data

[ JOX ) Add Variables from DataSet1

Data > Merge Files > Add Variables

[ NON J Add Variables to posttestdataex.sav[DataSet2]
Select a dataset from the list of open datasets or from a file to merge with the active dataset
o An open dataset _ One-to-one merge based on file order
pretestdataex.sav[DataSet1] © One-to-one merge based on key values

~ One-to-many merge based on key values

Select Lookup Table
DataSet2*
An external SPSS Statistics data file
DataSet1
Browse...
Non-SPSS Statistics data files must be opened in SPSS Statistics before they can be used as part of a merge. *Active dataset

- For a merge based on key values, files must be sorted in order of the
? Cancel Continue key values

Sort files by key values before merging

Key Variables:

@Use the Variables tab to add or remove key variables

? Reset Paste Cancel -




Prepping data: Merging pre/post test data

After:

Before:

Visible: 4 of 4 V

=l >
) & Attend & cest — Vil 2 6 f D & Score_posttest &) Attendance f Score_pretest var var
endance core_pretes var| isible: 2 of
4 9975309 0 48 & ID & Score_posttest var 4 661007 85 2 79
2 9948278 1 75 1 9975309 53 2 926172 50 0 48
3 9169427 4 ) B 9948278 0 3 1323956 93 3 88
4 8643086 3 90 5 9169427 95 4 ‘ 1328727 71 1 65
5 7988957 1 72 4 8643086 95 5 1767276 51 0 46
6 7509550 1 61 = 7988957 79 3 2331702 61 1 56
’ 6133087 2 g 6 7509550 67 7 | 3168177 67 0 66
: :;Z:E 2 :i : :ﬁig:: : 8 ‘ 3316521 57 0 54
0 4365151 3 83 o 5396215 m 9 3670778 63 1 56
™ 4303020 1 73 o 4365151 8 10 4303020 83 1 78
12 3670778 1 56 m 4303020 8 11 | 4365151 88 3 83
13 3316521 0 54 12 3670778 63 12 5396215 86 2 81
14 3168177 0 66 13 3316521 57 13 6115282 89 2 84
15 2331702 1 56 14 3168177 67 14 6133087 91 2 86
16 1767276 [} 46 G 2331702 61 s ‘ 7509550 = 1 o
i: iz:z: ; ZZ i: z:zs 2 16 7988957 79 1 72
= 926172 o n s 1323956 o 17 8643086 95 3 90
20 661007 2 79 5 926172 0 18 ‘ 9169427 95 4 90
21 o) 661007 I 19 9948278 80 1 75
22 — 20 9975309 53 0 48
— 22 21

Data View  Variable View 22 ‘

IBM SPSS Statistics Processor is ready # | |Unict (DataView) Variable View 23 |

/IBM SPSS Statistics Processor is ready Unicode:ON ‘




Any guestions/comments so far?




SPSS How to: One Sample T-test

* Analyze -> Compare Means -> One-Sample T Test

%2 One-Sample T Test X &3 One-Sample T Test X

Test Variable(s):

Test Variable(s): e
& Time Elapsed Befor.. || ———

¢ Time Elapsed Befor..|

&b Sex[Sex]
& Height (Inches) [Hei...

&> Sex[Sex]
& Height (Inches) [Hei...

Test Value: D

Test Value: Input the population mean
here



SPSS

ow to: One Sample T-test

ﬁ *Output13 [Document13] - IBM SPSS Statistics Viewer

File Edit View Data

Transform

Insert  Format

Analyze  Graphs

Utilities  Extensions

Window  Help ‘

Interpretation:

Our results indicate that the sample’s time
elapsed before sleep was significantly
higher(M=7.354, SD=2.33) than the population
average, t(99)=-4.691, p <.001.

SHeR NE e §ELE =25 H(d

=] Output
(8 Log
& {§] T-Test
(] Title
Notes
L& One-Sample Stati
-------- (& One-Sample Test

T-TEST
/TESTVAL=8.45
/MISSING=ANALYSIS
/VARIABLES=Duration
/CRITERIA=CI(.95).

=% T-Test

One-Sample Statistics

N @ Std. Deviation

Std. Error
Mean

Time Elapsed Before
Sleep (Mins)

100 \ 7.3541) 233632

.23363

One-Sample Test
TestValue=8.45

Mean
t df Sig. (2-tailed) Difference Lower Upper

95% Confidence Interval of the
Difference

Time Elapsed Before
Sleep (Mins)

k -4.691 ) 99\ 000

-1.5595 -.6323

/ -1.09540

e/

Soced

r

IIBM SPSS Statistics Processor is ready | | |Unicode:ON |—



SPSS How to: Independent Sample T-test

Analyze -> Compare Means -> Independent-Samples T Test

11029234 1 3 4 0 0 0 0 0 1
3 @ Independent-Samples T Test

Grouping variable:

4 Test Variable(s):

" | ¢ How many Advanced Placement (AP) exams will y... <] & How likely are you to go to college? (Mark one.) [Q81] Th|S va r|a ble Shou Id hOId the grou pS We’re

4 f How many Advanced Placement (AP) exams will y... f Are youknowledgeable aboutfinancial aid for college ... Bootstrap...

3 | ¢ How many Advanced Placement (AP) exams will y... & Do you think that you could afford to attend a public 4-... 1 1 H

3 f Has anyone fromyour school or GEAR UP ever sp... g ¢ f Do you have anyconcern about paying for your colleg... Compa rl ngl In thls Ca re Q83 aSked the respondents
P f How much do you think your parents/guardians ea... & Do you think that you could afford to attend a public 4-... H .

M| 2 11206 cresisa = cotsge success pianwith a coun.. of their high school and the values represent what

7 f After high school, what is the highest academic de... . . . .

4 ' Grouping Variable:

q 4? Please indicate the extent to which you agree or di... |383(2 3) | , t h e h |gh SC h OO I S a re .
3 f Please indicate the extent to which you agree or di... h)

3 | & Please indicate the extent to which you agree or di... [ Define Groups... 2= Kate”a H|gh SChOOI
(oK J[easte |( geset || cancel || Heip | 3 = Loara High School

3 01029422 0 3 4 0 0 0 1 0 1 0




SPSS How to: Independent Sample T-test

Group Statistics

Std. Error
School you attend: N Mean Std. Deviation Mean
How likely are youto goto  Katella High School 579 4.24 856 .036
ST e Loara High School 398 417 908 045
Are you Katella High School 586 67 472 .019

knowledgeable ahout

financial aid for college
and the cost and benefits Loara High School 403 78 A7 021

to you of going to college

Descriptive statistics
o Mean, standard deviation, N




SPSS How to: Independent Sample T-test

Independent Samples Test

Levene's Test for Equality of

Variances t-test for Equality of Means
95% Confidence Interval of the
Mean Std. Error Difference
Slg/\ t Sig. (2-tailed) Difference Difference Lower Upper
How likely are youto goto  Equal variances - .948 |1 138 I 065 057 -.047 ATT
college? (Mark one.) assumed N
Equal variances not 1.125 819.985 .065 .058 -.048 178
assumed YN
Are you Equal variances 61.875 .000 -3.757 987 -109 029 - 167 -.052
knowledgeable about assumed
financial aid for college =
and the cost and benefits ~ Edualvariances not — |-3.343 927.253 -109 028 -165 -.054

to you of going to college assumed

Which results do we report?
First we check the Levene’s Test sig. value.

If it is BELOW .05 (significant), we look at the equal variances
NOT assumed.

If it is ABOVE .05 (not significant), we look at the equal variance

assumed.

Interpretation:

There is no significant differences between the
high schools in their likeliness to go to college,
t(975) = 1.138, p > .05.

There is a significant difference between Katella
High School (M=.67, SD=.472) and Loara High
School (M=.78, SD=.417) in their knowledge
about college costs, t(927.25) = -3.843, p < .001.



SPSS How to: Paired Samples T-test

Analyze > Compare Means > Paired-Samples T Test

Variablel: __Variable2:

Pre-test dataj / Post-test data

-

1l ——lssiinee el

1 #3 Paired-Samples T Test

il Ability to work in groups [Post_Group]

{l Communication skills [Post_CommSkill]

{l Group activities allow me to practice team leadershi...
{I Group activities allow me to practice team leadershi...
{I Hands-on activities help me learn [Post_Handson]
{l Hands-on activities help me learn [Pre_Handson]

Display Variable Names R UP activity befo...

) ) AR UP Leadersh...
@© Display Variable Labels “AR UP Leaders.
@® Sort Alphabetically in the Leadershi...

Sort By File Order

Sort By Measurement Level onfident]
nfident]

Variable Information...

il | believe | have the tools to practice leadership. [Pre...
{l | believe in myself. [Post_Believe]

{I | believe in myself. [Pre_Believe]

{I | can communicate effectively [Post_CommEff]

{I | can communicate effectively [Pre_CommEff]

{I | can grow through my work with others. [Post_Grow]
d | can grow through my work with others. [Pre_Grow]

{I | collaborate with others to get my work done [Post_... | |

il | collaharate with others ta aet mvwark done Pre ¢

to develop relati...
to develop relati...

5 Saturday Acade...
{l | believe | can use what | learn at this Saturday Acade...
il | believe | have the tools to practice leadership. [Post...

]

Paired Variables: \

Pair IVariabIe1 IVariabIe2

ol Hands-on activities .. il Hands-on activities ...
#l 1 am confidentin my ... gl | am confidentin my ...
ol | believe | have the to... Jif | believe | have the t...

il | believe in myself. [.. Jii | believe in myself. [...

oW N =

(0] (st (meset) (canet) (i)

1028395

4.00 4.00 4.00 4.00

*make sure to put
them in the right
order



Output - Paired Samples t-test

Paired Samples Statistics

Std. Error
Mean N Std. Deviation Mean
B e 2 52630 1222 Interpretation:
Hands-on activities help 3.3636 22 49237 10497
me |earn
FHE DG 32174 23 51843 10810 Our sample of students indicated significantly
| am coniidentin my 3u7e o\ s 11043 more confidence after the professional
Pair3  Ibelieve | have the tools 3.1739 23 57621 12015 development WOFkShOp (M=3.344, SD=507) in
to practice leadership. .
I believe | have the tools 33913 23 49901 10405 comparison to before (M=3087, 5D=596),

to practice leadership.

Paird | believe in myself. 3.0870 23 59643 12436 t(33) = '2336; p <05

| believe in myself. 3.4348 23 .50687 10569

M e WM eI e

Paired Differences
95% Confidence Interval of the

Std. Error Difference
Mean Std. Deviation Mean Lower Upper t df Sig. (2-tailed)

Pair1  Hands-on activities help -.27273 55048 11736 -.51680 -.02866 -2.324 21 .030

me learn - Hands-on

activities help me learn
Pair2 |am confidentin my -.13043 .54808 11428 -.36744 10657 -1.141 22 266

ideas. - | am confidentin

my ideas.
Pair3 |believe | have the tools -.21739 59974 125058 -.47674 .04195 -1.738 22 .096

to practice leadership. - |
believe | have the tools to
practice leadership.

Pair4 | believe in myself. - | -.34783 71406 14889 -.65661 -.03904 -2.336 22 .029
believe in myself.




Any guestions/comments so far?




SPSS How to: Multiple Linear Regression

Utilities Extensions Window Help

Analyze > RegrESSion > Linear” Analyze Graphs

Power Analysis PSS Statistics Data Editor
Question: What factors predict for job e
satisfaction? And to what extent? Wit

Compare Means

General Linear Model
Generalized Linear Models
Mixed Models

Correlate

Regression

Loglinear

Neural Networks

Classify

Dimension Reduction
Scale

Nonparametric Tests
Forecasting

Survival

Multiple Response

78 Missing Value Analysis... B Nonlinear...

Multiple Imputation R Weight Estimation...
Complex Samples 'R! 2-Stage Least Squares...
iy Simulation...
Quality Control

gﬁ:ﬁ?'&:fk:;:gpm' ploseng. ™ Optimal Scaling (CATREG)... -

es f workplace f tasks var
74 49 54

72 41 46
9 30

[Z Automatic Linear Modeling...
'® Linear...

74 Curve Estimation...

B2 Partial Least Squares... =

& Binary Logistic...

R Multinomial Logistic...
R Ordinal... B
F% Probit... ~

VVVVVVVVVEVAVVVVVVVYVYYVY|Y

A\ 4
|

&, Quantile...




SPSS How to: Multiple Linear Regression

| NON | Linear Regression: Statistics
00 @ Linear Regression B o ffici o .
Regl’eSSIOH Coefficients Model fit
: &) Case identifier [id] - Deple';d::t: with my job [overall ‘ Statistics... > EStimateS o
| @ Sex sex) P —— Plots... R squared change
Date of birth [bday] ‘4 Confidence interval = o
7 | ¢ I have a nice supervisor [supervisor] Previous Next Save... . C =l t L Descri ptlveS
= | ¢ I have good labor conditions [conditions] Independent(s): Level(%)-
. b Opti - p— a o
1 g :whave nce coll'eague(: {collekas?uesll #"I have a nice supervisor [supervisor] prions 95 Part and partial correlations
g f My workp. a.ce IS go.o WOL place ¢ | have good labor conditions [conditions] Style... S 3 . -
| | y work is interesting [tasks] Sl | have nice colleagues [colleagues] Bootstra, Covarlance matrix Collineal’ity diag nostics
p...
: Method: Enter ~Residuals
d Selection Variable: — .
I » | | Rule... Durbin-Watson
[ o (el ‘ ~ Casewise diagnostics
f - ‘WLS Weight: ‘ ) Outliers outside: 3 standard deviations
i ? Reset Paste cancel  (NOKIN All cases
: el




Output: MLR

R = correlation coefficient
Interpretation: There was 69.5%
correlation between X, Y, Z (predictor)

variables and A (criterion/dependent)
variable..

R-Square = coefficient of
determination; proportion of variance
explained by the independent
variables

Interpretation: Our independent
variables account for 48.3% of the
variability in our dependent variable..

Adjusted R-Square = only accounts for
significant variables in the model,
which is why it’s always lower than R-
square

Model Summary

Adjusted R Std. Error of
Model R R Square Square the Estimate
1 .695% .483 424 17.631

a. Predictors: (Constant), My work is interesting, | have
good labor conditions, My workplace is good, | have
nice colleagues, | have a nice supervisor

ANOVA?
Sum of
Model Squares df Mean Square F Sig.
1 Regression 12761.123 5 2552.225 8.210 .000°
Residual 13677.757 44 310.858
Total 26438.880 49

a. Dependent Variable: I'm happy with my job

b. Predictors: (Constant), My work is interesting, | have good labor conditions, My
workplace is good, | have nice colleagues, | have a nice supervisor

Coefficients?

Standardized
Unstandardized Coefficients Coefficients

ANOVA results indicate if the model is a good
fit.

Interpretation: The table shows that the
independent variables statistically significantly
predict the dependent variable, F(5, 55) =
8.210, p < .001

95.0% Confidence Interval for
B

Model B Std. Error Beta Sig. Lower Bound  Upper Bound

1 (Constant) 5.854 10.120 .566 -14.541 26.250
| have a nice supervisor 117 .176 .097 .510 -.238 472
| have good labor .363 114 .369 3.182 .003 .133 .593
conditions
| have nice colleagues .103 .145 .098 483 -.190 .396
My workplace is good .256 .139 225 1.836 .073 -.025 .537
My work is interesting .334 .126 .299 2.660 011 .081 .587

a. Dependent Variable: I'm happy with my job




Output: MLR

Model Summary

Adjusted R Std. Error of
Model R R Square Square the Estimate

1 .6952 483 424 17.631

a. Predictors: (Constant), My work is interesting, | have
good labor conditions, My workplace is good, | have
nice colleagues, | have a nice supervisor

a . .
" ANOVA Our regression equation:
Model Suares | df | MeanSqure | F | So Job satisfaction = 5.854 + .117*supervisor + .363*conditions
1 Regression 12761.123 5 2552.225 8.210 .000 .
Residual 13677.757 44 310.858 + .103*co||eagues + .256*W0rkp|ace +.334*interest
Total 26438.880 49

a. Dependent Variable: I'm happy with my job

b. Predictors: (Constant), My work is interesting, | have good labor conditions, My
workplace is good, | have nice colleagues, | have a nice supervisor

Coefficients?
Standardized 95.0% Confidence Interval for
standardi2gd Coefficients Coefficients B
Model B Std. Error Beta t Sig. Lower Bound  Upper Bound
1 (Constant) 5.854 10.120 .578 .566 -14.541 26.250
| have a nice supervisor 117 .176 .097 .664 .510 -.238 472
| have good labor .363 114 .369 3.182 .003 1133 .593
conditions
| have nice colleagues .103 .145 .098 .707 .483 -.190 .396
My workplace is good \ .256 .139 .225 1.836 .073 -.025 .537
My work is interesting \ 334 / 126 299  2.660 011 081 587

a. Dependent Variable: I'm happy with W




MLR: Finding the best model

Coefficients?
Standardized 95.0% Confidence Interval for
Unstandardized Coefficients Coefficients B
Model B Std. Error Beta t Sig. Lower Bound  Upper Bound
1 (Constant) 5.854 10.120 .578 .566 -14.541 26.250
| have a nice supervisor 117 .176 .097 .664 .510 -.238 472
| have good labor .363 114 .369 3.182 .003 .133 .593
conditions
| have nice colleagues .103 .145 .098 .707 483 -.190 .396
My workplace is good .256 oIS 225 1.836 .073 -.025 .537
My work is interesting .334 .126 .299 2.660 .011 .081 .587
a. Dependent Variable: I'm happy with my job
0 Linear Regression
Dependent: L
Statistics...
&> Case identifier [id) I'm happy with my job [overal \ —
& Sex [sex] “Block 1 of 1 Plots...
Date of birth [bday)
& I have a nice supervisor [supervisor] Previous Next Save...
4? | have good labor conditions [conditions] Ind Adant(c). -
& 1 have nice colleagues [colleagues) - G _ Options...
& folace | 9 ) gla & 1 have a nice supervisor [supervisor]
% My workg ce is good lwo:( place] & < I'have good labor conditions [conditions] Style...
My work is interesting [tasks] & I have nice colleagues [colleagues]
_ Bootstrap...
e r—
Selection Variable: Remove
» | Backward
Forward
Case Labels:
WLS Weight:

? Reset Paste

Cancel

Which factors contribute the most for
predicting job satisfaction?

Not all our predictors are significant; we can
further simplify our model to be better fit

Stepwise Regression: Remove or add predictor
that would result in model with the best fit
Backward Regression: Adds all predictors then
sequentially removed

Forward: Each predictor is added sequentially




Output: Stepwise Regression

Model Summary

Adjusted R Std. Error of Our regression equation:
ode R R Square Square the Estimate R . - .
R e e Job satisfaction = 10.959 + .408*conditions + .364*workplace + .337*interest
2 614° .377 .351 18.719
3 .680¢ .462 .437 17.587 . .. . .
a- Predictors: (Constand, | have good labor conditons Predictors: Labor conditions, interesting work, and good workplace

b. Predictors: (Constant), | have good labor conditions, My
work is interesting

c. Predictors: (Constant), | have good labor conditions, My
work is interesting, My workplace is good

Coefficients?
ANOVA? Standardized
Sum of Unstandardized Coefficients Coefficients
Model Squares df Mean Square F Sig. Model B Std. Error Beta t Sig.
1 Regression 6537.379 1 6537.379  15.767 .000° 1 (Constant) 40.913 7.099 5.763 .000
Residual 19901.501 48 414.615 | have good labor .489 123 .497 3.971 .000
Total 26438.880 49 conditions
2 Regression 9969.814 2 4984.907 14.226 .000¢ 2 (Constant) 21.113 9.089 2.323 .025
Residual 16469.066 47 350.406 | have good labor 444 114 451 3.890 .000
Total 26438.880 49 conditions
EENRRNRECicsionly  12211.599 3 4070.533  13.161  .000° My work is interesting 406 .130 .363 3.130 .003
fesidual L4227.281 46 309.289 3 (Constant) 10.959 9.335 1.174 246
Total 26438.880 49
- - - - | have good labor .408 .108 415 3.778 .000
a. Dependent Variable: I'm happy with my job conditions
b. Predictors: (Constant), | h d lab diti . .
redictors: (Constan), | have good labor conditions o My work is interesting 364 123 326 2.964 .005
c. Predictors: (Constant), | have good labor conditions, My work is interesting -
d. Predictors: (Constant), | have good labor conditions, My work is interesting, My My workplace is good :337 -125 -296 2.692 -010

workplace is good

a. Dependent Variable: I'm happy with my job




THE END ©
Any questions/comments?




